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CHAPTER 1

Introduction
A snippet is an important file used for single-sourcing that acts sort of like a miniature topic. In a
snippet, you can insert and format text, tables, pictures, and whatever else can be included in a normal topic. We’re not usually talking about single words or phrases; that’s what variables are for. A
snippet can be inserted into one or more topics throughout your project. You can even insert them
into other snippets, creating nested snippets.
The major benefit of using snippets is that you only have to create your content once, rather than
having to type the same information in each topic where you want to use it. If you need to modify
the content of a snippet, you only need to change it in one place and the change is made automatically everywhere that the snippet is added.
Snippets are contained in their own files (using an .flsnp file extension). You can therefore share
them with other authors or use them in other projects. If you insert a snippet that is stored outside
of your project, the file is copied to your project. The traditional location to store a snippet in the Content Explorer is in the Resources\Snippets folder. However, you can store it anywhere in the Content
Explorer that you like.
This chapter discusses the following:
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Text and Block Snippets
There are two types of snippets: text and block. This is determined by the way you insert the snippet.
n

Text Snippets If you insert a snippet on a line where other content exists, it is inserted as a
text snippet. Therefore, if you want to insert a snippet on a blank line and also type other text
before or after it, you need to type the text first and then insert the snippet afterward. If you
have a snippet containing multiple paragraphs and insert it within a line of text, the snippet
becomes just one continuous line of text because it is a text snippet.

n

Block Snippets If you insert a snippet on a blank line in a topic, it is inserted as a block snippet
and takes up all of the room so that no other content can be added. Block snippets are best
for multiple paragraphs, lists, and other large chunks of content.

When you create a text or block snippet, it displays surrounded by brackets (if you have markers
turned on).
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Condition Tags and Snippet Conditions
You can apply a condition tag to a snippet so that it is included in some targets but not in other targets.
You can also create snippet conditions. Snippet conditions are condition tags that you can apply to
content within snippets. With snippet conditions, you can separate certain snippet content so that it
displays in some snippets, topics, or master pages but not in others. This allows you to use one snippet for many purposes, rather than having to create multiple snippets. Whereas regular conditions
are included or excluded at the target level, snippet conditions are included or excluded at the snippet, topic, or master page level. See "Using Snippet Conditions" on page 42.
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Snippets and Auto Suggestions
Flare recognizes when you are typing content that matches existing snippets in your project. This
makes it a very fast and convenient way to single-source your content.
EXAMPLE
Let's say you work on a team of 15 writers and there are a series of snippets in all of
your projects that begin with the same three words—For more information…
Perhaps each person knows to start typing those words in certain places. But what if a
snippet already exists with the full content that the writer needs? Without knowing that,
a person might spend time typing all of the content, and maybe even create a new snippet for future use. But if Auto Suggestion is enabled, as soon as a person types a certain number of characters, all matching snippets are shown in the Auto Suggestion
popup. Therefore, the writer can quickly find and select the appropriate snippet.
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Tasks Associated with Snippets
Following are the main tasks involved with using snippets.
n

Add Snippets You can add a new snippet (without necessarily having any topic open). See
"Adding New Snippets" on page 13.
NOTE: You can also import an existing snippet from outside your project.

n

Create Snippets From Content If you have already added content in your topic and want to
turn that content into a snippet, you can create a snippet out of that existing content using
the Home ribbon or Format menu. See "Creating New Snippets" on page 11.

n

Edit Snippets You cannot modify the snippet at its location in the topic. When you insert a snippet into the topic, the content is displayed, but it is held in a separate snippet file. In the topic
the snippet marker is represented by brackets. To modify a snippet you need to open it by
right-clicking on it and selecting Open Link, or you can open it from the Content Explorer. Then
you can make changes to it in the XML Editor. See "Editing Snippets" on page 21.

n

Insert Snippets After you create or add snippets, you can insert them into any topic in your project. See "Inserting Snippets" on page 16.
NOTE: You can also create nested snippets (i.e., a snippet within a snippet). To do
this, simply open a snippet and then insert another snippet into it.

n

Opening Snippets You can open existing snippets to review them and make modifications to
them. See "Opening Snippets" on page 22.

n

Using Snippet Conditions Snippet conditions are condition tags that you can apply to content
within snippets. See "Using Snippet Conditions" on page 42.
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WARNING: It is recommended that you avoid creating links to snippets.This is primarily due
to the nature of snippets, which are designed to be inserted into multiple files. Let's say you
have a heading style in a snippet and that snippet is then inserted into 12 different topics. In
another topic, you might decide to create a cross-reference that points to the heading in
that snippet. But which of those 12 topics is it supposed to point to in the output? There is
no way for Flare to know this, so you could end up with some very undesirable results. For
this reason, it's a good idea not to link to any content in a snippet.

NOTE: Although it is possible to open any Flare files in a third-party editor, it is recommended that you avoid editing these files in certain programs while Flare is running. For
example, opening a stylesheet in Notepad is not an issue. But you might experience problems if you open a topic or snippet in Microsoft Word and edit it while Flare is running.
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CHAPTER 2

Creating New Snippets
Snippets are pre-set chunks of formatted content that you can use over and over. You can create
snippets from existing content.
The following steps show you how to create new snippets from existing content.
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HOW TO CREATE A NEW SNIPPET FROM EXISTING CONTENT
1. Open the topic.
2. In the XML Editor highlight the content that you want to turn into a snippet.
3. Select the Home ribbon. In the Snippet section select Create Snippet.
4. In the Snippet File field, type a new name for the snippet.
It is recommended that you leave the project folder selection as "Resources/Snippets" (or
select a subfolder that you have created in the Snippets folder). After the snippet is created,
you can see the snippet file in the Content Explorer.
5. If you want the snippet to replace the highlighted text in the topic, make sure that a check
mark is displayed in Replace Source Content with the New Snippet.
Why would you leave this box unchecked? Let's say you want to create two snippets and they
are going to be very similar. You might create the first snippet, make a few changes to the
text within the dialog, and leave this box unchecked. That snippet is created but not inserted
into the topic. Then you can create the second snippet with this box checked. Flare will both
create the snippet and insert it into the topic, replacing the highlighted text.
6. Click Create. The snippet is added to the Content Explorer and opens in the topic page in the
XML Editor. The snippet is surrounded by brackets (if markers are turned on).

7. Click

to save your work.

NOTE: You can also import an existing snippet from outside your project. See "Importing
Snippets" on page 28.
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CHAPTER 3

Adding New Snippets
There are two ways to create a snippet.
n

Create Snippets From Content If you have already typed content in your topic and want to
turn that content into a snippet, you can create a snippet out of that existing content using
the Home ribbon or Format menu. You can then insert the snippet into other topics where you
want it to appear.
OR

n

Add Snippets You can add a new snippet (without necessarily having any topic open) and then
insert the snippet into the topics where you want it to appear.
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The following steps show you how to add new snippets.

HOW TO ADD A NEW SNIPPET
1. Do one of the following, depending on the part of the user interface you are using:
(Recommended) Right-Click In the Content Explorer, right-click on a folder and from the
context menu select New > Snippet.

n

TIP: When adding a new file to the Content Explorer, the recommended
method is to right-click on the folder in the Content Explorer and use the New
menu option. This is the most efficient way to direct the new file to the folder
where you want to store it. That's because the Add File dialog opens when you
add a new content file, and this method ensures that the folder you want is
already selected in that dialog.
Ribbon Select the Project ribbon. In the Content section select New > Snippet.

n

The Add File dialog opens.
2. In the File Type field at the top, make sure Snippet is selected.
3. In the Source area select one of the following:
n

New from template Choose either the factory template file or one of your own customized template files as a starting point. The new file will take on all of the settings contained in the template. If you want to use the factory template provided by Flare, expand
the Factory Templates folder and click on a template file. If you want to use your own customized template file, expand the appropriate folder and click on a file. For more information about templates, see the online Help.

n

New from existing Choose an existing file of the same type as a starting point for your
new file. As with template files, your new file will take on all of the settings contained in
the file you select. To use this option, click the browse button
log to find a file, and double-click it.

, use the Open File dia-

4. (Optional) The Folder field is automatically populated with the folder that has focus in the Content Explorer. If you want to place the file into a folder that you previously created in the Content Explorer, in the Folder field click
default location.

CHAPTER 3

and select the subfolder. Otherwise, keep the
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NOTE: If you want to place non-topic files in a traditional default folder, you must first
make sure that folder exists in the Content Explorer. If it does not exist, you can easily
add it.

Non-Topic File Type

Traditional Default Folder in Content Explorer

Image

Resources\Images

Master Page

Resources\MasterPages

Multimedia

Resources\Multimedia

Page Layout

Resources\PageLayouts

Snippet

Resources\Snippets

Stylesheet

Resources\Stylesheets

Table Stylesheet

Resources\TableStyles

5. In the File Name field, type a new name for the snippet.
6. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click
want to apply. Click OK.

and select the conditions you

7. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the dialog. Next to the File Tags field, click

and select the file tags you want to apply. Click OK.

8. Click Add. The snippet is added to the Content Explorer and opens in its own page in the XML
Editor with some default text for you.
9. Now simply click inside the snippet page in the XML Editor and start typing text (replacing the
default text shown) or adding any other elements (e.g., styles, tables, images, hyperlinks, multimedia) appropriate for the snippet.
10. Click
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to save your work.
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CHAPTER 4

Inserting Snippets
After you create or add snippets, you can insert them into a content file (e.g., topic, snippet). You
can do this by using user interface options, which let you search for a snippet, or you can simply
drag an existing snippet from the Content Explorer or File List window pane.

HOW TO INSERT A SNIPPET—INSERT SNIPPET LINK DIALOG
1. Open the content file (e.g., topic, snippet).
2. Place your cursor where you want to insert the snippet.
3. Do one of the following, depending on the part of the user interface you are using:
n

Ribbon Select the Insert ribbon. In the Single Source section select Snippet.

n

Local Toolbar Click the face of the

button.

OR
Click the down arrow next to

, then select More Snippets.

n

Keyboard Shortcut Press CTRL+R.

n

Right-Click Right-click in the editor and select Insert > Snippet. This context menu
option is available only when your cursor is located in certain places in the editor (e.g.,
not in a drop-down effect).

The Insert Snippet Link dialog opens.
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4. Navigate to the snippet that you want to insert and select it. By using the buttons in the local
toolbar, you can view all snippet files in a list, view files in their folder structure, and use other
options. If you want to add one of your 20 most recently used snippets to the project, you can
select a snippet from the Recently Used Snippets group. If you want to add one of your
pinned—or favorite—snippets to the project, you can select a snippet from the Pinned Snippets group. You also can click
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Button

Description
Shows all of the files in the project in a list in the area below. If you
click the button again, it switches to a folder tree view. In the list, you
can click the File, Type, or Path column headers to sort the list alphabetically by that column data.
Shows or hides the folders that the files are stored in.
Shows or hides the files. If you click this button when the Show Folders
button
is selected, the area splits into two. The folder is shown on
the left side, and the files and subfolders within it are shown on the
right.
If the Show Files button
is the only one selected, you can click
this button to move up one folder level.
Lets you filter the kinds of files shown below. Depending on the task
you are performing, this field may already be populated with the most
appropriate file type(s).

NOTE: If you select a snippet file outside the project, that file is then copied and
placed inside the project. The image file is stored in the Resources\Snippets folder of
the Content Explorer.
5. Click OK. The snippet is inserted and is surrounded by brackets (if markers are turned on).

6. Click
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to save your work.
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HOW TO INSERT A SNIPPET—DRAG AND DROP METHOD
1. Open the Content Explorer or File List window pane.
If necessary, make sure you float and position the window pane or editor so that you can see
both it and XML Editor at the same time.
2. Click and drag the snippet from the Content Explorer or File List window pane to the location
where you want it in the XML Editor and drop it.
3. Click

to save your work.

HOW TO INSERT A SNIPPET—LOCAL TOOLBAR DROP-DOWN METHOD
1. Open the content file (e.g., topic, snippet).
2. Place your cursor where you want to insert the snippet.
. This
3. In the local toolbar at the top of the XML Editor click the down arrow next to
expands the Insert Snippet drop-down, where you can see your pinned snippets and the 20
most recently used snippets.
4. Navigate to the snippet that you want to insert and select it.
5. Click

to save your work.

NOTE: If you need to insert a snippet that does not appear in the Pinned Snippets or
Recently Used Snippets groups, you can select More Snippets to open the Insert Snippet
Link dialog.

NOTE: Snippets must appear in the Recently Used Snippets group before they can be
pinned. If the snippet you want to pin does not appear in the Recently Used Snippets group,
you can add it to a content file by dragging it from the Content Explorer or using the Insert
Snippet Link dialog.

NOTE: The Recently Used Snippets and Pinned Snippets groups show the relative path location of each snippet. Hover over any snippet to see its full file path.
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NOTE: You can expand or collapse the Recently Used Snippets and Pinned Snippets groups
by clicking the arrows next to each group name.

NOTE: If you have the snippet feature in Auto Suggestions enabled, you can quickly insert
snippets into content files when you begin typing matching text.

NOTE: There are two types of snippets: text and block. This is determined by the way you
insert the snippet.
n

Text Snippets If you insert a snippet on a line where other content exists, it is inserted
as a text snippet. Therefore, if you want to insert a snippet on a blank line and also
type other text before or after it, you need to type the text first and then insert the
snippet afterward. If you have a snippet containing multiple paragraphs and insert it
within a line of text, the snippet becomes just one continuous line of text because it is
a text snippet.

n

Block Snippets If you insert a snippet on a blank line in a topic, it is inserted as a block
snippet and takes up all of the room so that no other content can be added. Block
snippets are best for multiple paragraphs, lists, and other large chunks of content.

When you create a text or block snippet, it displays surrounded by brackets (if you have
markers turned on).

NOTE: If you want to change how snippets look when they're inserted in the XML Editor, you
can change the MadCap|snippetBlock or MadCap|snippetText styles (for block and text
snippets, respectively) in the Stylesheet Editor. This does not affect the output. For more
information see the online Help.
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CHAPTER 5

Editing Snippets
After you create or add a new snippet to your project, you can insert it into any of your topics. Later,
if you decide that the snippet needs to be altered, you can do so easily using the steps below. When
you edit a snippet, the changes are automatically reflected in any topics where you have inserted
the snippet previously.

HOW TO EDIT A SNIPPET
1. Use one of the following methods to open the snippet that you want to modify.
n

Right-click on the snippet in a topic where it is inserted and select Open Link.
OR

n

Locate the snippet in the Resources\Snippets folder in the Content Explorer and
double-click it.

2. In the XML Editor make the necessary changes to the snippet, just as you would edit any other
document.
3. Click

to save your work.

NOTE: If you want to change how snippets look when they're inserted in the XML Editor, you
can change the MadCap|snippetBlock or MadCap|snippetText styles (for block and text
snippets, respectively) in the Stylesheet Editor. This does not affect the output. For more
information see the online Help.
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CHAPTER 6

Opening Snippets
After you create or add snippets to your project, they are stored in the Content Explorer (Content\Resources\Snippets). You can open as many existing snippets as you want at one time and
make modifications to them. Each snippet displays in its own page of the XML Editor and remains
accessible as you work. As you open more snippets or other elements (e.g., topics, targets, tables of
contents), each page displays in the appropriate editor (e.g., XML Editor, Target Editor, TOC Editor).
By default, the most recently opened page is on the left side of the editor section in Flare, and the
previously opened pages shift to the right. The active page displays on top of the other pages, and
you can make any page the active one (or "the one on top") by simply clicking its tab.
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HOW TO OPEN A SNIPPET FROM THE QUICK LAUNCH BAR
The Quick Launch bar allows you to search for any Flare file or command. It is located in the upperright corner of the interface. You can press CTRL+Q on your keyboard to move focus to the Quick
Launch bar so you can begin typing.

1. In the Quick Launch bar, type a few letters of the name of the file you want to open. Any available results appear in a drop-down list.
2. From the list, click the name of the file.

HOW TO OPEN A SNIPPET FROM THE CONTEXT MENU
1. Open a topic where the snippet is inserted.
2. Right-click on the snippet and select Open Link.The snippet opens in its own page of the XML
Editor.

CHAPTER 6

23

HOW TO OPEN A SNIPPET FROM THE CONTENT EXPLORER
1. Open the Content Explorer.
2. Expand the Resources folder, and double-click the Snippets subfolder to open it (unless you
have stored these files in a custom folder).
3. Do one of the following:
n

Locate and double-click the snippet file (e.g., NameOfSnippet.flsnp) that you want to
open.

n

Locate and click the snippet file (e.g., NameOfSnippet.flsnp) that you want to open. In
the local toolbar, click

.

The snippet opens in its own page of the XML Editor.
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CHAPTER 7

Additional Snippet Tasks
In addition to the many features already covered in this guide, there are many more snippet-related
tasks that you can perform in Flare.
This chapter discusses the following:
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Converting Snippets to Text
After you create or add a new snippet to your project, you may decide that you want the snippet to
be regular text instead. Rather than retyping the snippet, you can convert the snippet to text using
the steps below.

HOW TO CONVERT A SNIPPET TO TEXT
1. Open the topic.
2. In the XML Editor, right-click the snippet that you want to convert to text.
3. From the context menu, select Convert to text. The snippet is converted to text.
4. Click
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to save your work.
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Deleting Snippets
If necessary, you can delete a snippet that you have added to a topic.

HOW TO DELETE A SNIPPET
1. Open the topic containing the snippet.
2. In the XML Editor, right-click the snippet that you want to delete.
3. From the context menu, select Delete. The snippet is removed from the topic.
4. Click
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Importing Snippets
You can create new snippets (FLSNP files) within your project. But if you already have created snippets in another project and want to reuse them in your current project, you can import those snippets.

HOW TO IMPORT A SNIPPET
1. Select the Project ribbon. In the Content section select New > Snippet.
The Add File dialog opens.
2. Select New from existing and click

.

3. Find and select the snippet file that you want to import.
4. Click Open. The Source File field now contains the path to the file that you are importing. Also,
the name of the file is displayed in the File Name field.
5. In the Folder field select a location to store the snippet in the project.
6. If you want to give the snippet a different name than that for the imported file, click in the File
name field and replace the text.
7. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click
want to apply. Click OK.

and select the conditions you

8. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the dialog. Next to the File Tags field, click

and select the file tags you want to apply. Click OK.

9. Click Add. The snippet is added to the Resources\Snippets folder in the Content Explorer and
opens in its own page in the XML Editor.
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Inserting Page Numbers into Frames
Supported In:

One type of content that you are likely to add to a frame is a page number, which is actually a snippet that serves as a placeholder for a page number in the output.

HOW TO INSERT A PAGE NUMBER INTO A FRAME
1. Open a page in a page layout.
2. Click on the frame to which you want to add a page number.
NOTE: You can insert a page number only into header, footer, and decoration frames.
You cannot insert a page number into a body frame (which automatically displays
content from your topics).
3. Do one of the following, depending on the part of the user interface you are using:
n

Local Toolbar In the local toolbar, click

.

n

Right-Click Right-click the frame and select Select Frame Text.

The Select Frame Text dialog opens.
4. In the Template Folders section, select a template.

NOTE: You can click the Manage Templates button
if you want to open the Template Manager. This lets you manage any of your template files (e.g., add new templates, enter descriptions for templates). For more information see the online Help.
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5. In the Templates section, select one of the page number snippets.
n

- page -.flsnp Displays a page number surrounded by dashes (e.g., - 53 -).

n

page (pagecount).flsnp Displays the current page number, followed by the total number
of pages in parentheses.

n

Page n of N.flsnp Displays the current page number and the total number of pages in the
document (e.g., Page 13 of 70).
TIP: If you want to change the look of the page number (e.g., remove the dashes or
parentheses), you can do so easily. To edit the text or content around a page number,
continue inserting the page snippet as it is. After it is added to the frame, click on the
frame and press F2. In the Frame Contents window pane, you can modify it as necessary.

6. Click OK.
7. Click
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Pinning Snippets
You can pin your favorite snippets so you can easily find them again later. Pinned snippets appear in
a group that you can expand or collapse. This is a way to limit the list of snippets to those that you
use the most.
You can pin any snippet that appears in the Recently Used Snippets group. This group lists your 20
most recently used snippets. See "Using Snippet Groups" on page 55.

HOW TO PIN A SNIPPET—INSERT SNIPPET LINK DIALOG
1. Open the content file (e.g., topic, snippet).
2. Do one of the following, depending on the part of the user interface you are using:
n

Ribbon Select the Insert ribbon. In the Single Source section select Snippet.

n

Local Toolbar In the local toolbar at the top of the XML Editor click the face of the
button.
OR
In the local toolbar at the top of the XML Editor click the down arrow next to
select More Snippets.

, then

n

Keyboard Shortcut Press CTRL+R.

n

Right-Click Right-click in the editor and select Insert > Snippet. This context menu
option is available only when your cursor is located in certain places in the editor (e.g.,
not in a drop-down effect).

The Insert Snippet Link dialog opens.
3. From the Recently Used Snippets group, select the snippet you want to pin. A pin
to the right of the snippet.

appears

NOTE: Snippets must appear in the Recently Used Snippets group before they can be
pinned. If the snippet you want to pin does not appear in the Recently Used Snippets
group, you can add it to a content file by dragging it from the Content Explorer or
using the Insert Snippet Link dialog.

CHAPTER 7

31

. The pin changes to
to show that the snippet has been pinned
4. To pin the snippet, click
to the list. Pinned snippets are added to the Pinned Snippets group in alphabetical order.
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5. To unpin the snippet, click the pin again and it will be moved back to the bottom of the
Recently Used Snippets group.
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6. Click OK.
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HOW TO PIN A SNIPPET—LOCAL TOOLBAR DROP-DOWN METHOD
1. Open the content file (e.g., topic, snippet).
2. In the local toolbar at the top of the XML Editor click the down arrow next to
expands the Insert Snippet drop-down.
3. From the Recently Used Snippets group, select the snippet you want to pin. A pin
to the right of the snippet.

. This
appears

NOTE: Snippets must appear in the Recently Used Snippets group before they can be
pinned. If the snippet you want to pin does not appear in the Recently Used Snippets
group, you can add it to a content file by dragging it from the Content Explorer or
using the Insert Snippet Link dialog.

. The pin changes to
to show that the snippet has been pinned
4. To pin the snippet, click
to the list. Pinned snippets are added to the Pinned Snippets group.
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5. To unpin the snippet, click the pin again and it will be moved back to the bottom of the
Recently Used Snippets group.
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EXAMPLE
Four snippets have been added to the Pinned Snippets group. Other recently used snippets can still be seen in the Recently Used Snippets group; you can add any of these
snippets to the Pinned Snippets group at any time.

NOTE: The Recently Used Snippets and Pinned Snippets groups show the relative path location of each snippet. Hover over any snippet to see its full file path.

NOTE: You can expand or collapse the Recently Used Snippets and Pinned Snippets groups
by clicking the arrows next to each group name.
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Replacing Snippets
After you create or add a new snippet to your project, you can insert it into any of your topics. Later,
if you decide that a different snippet is a better fit for the topic, you can select a new snippet to
replace it. When you replace a snippet, it only affects the instance that you selected.

HOW TO REPLACE A SNIPPET
1. Right-click on the snippet where it is inserted and select Select New Snippet. The Insert Snippet Link dialog opens.
2. Navigate to the snippet that you want to insert and select it. By using the buttons in the local
toolbar, you can view all snippet files in a list, view files in their folder structure, and use other
options. If you want to add one of your 20 most recently used snippets to the project, you can
select a snippet from the Recently Used Snippets group. If you want to add one of your
pinned—or favorite—snippets to the project, you can select a snippet from the Pinned Snippets group. You also can click

CHAPTER 7

to find and select a snippet file outside of the project.
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Button

Description
Shows all of the files in the project in a list in the area below. If you
click the button again, it switches to a folder tree view. In the list, you
can click the File, Type, or Path column headers to sort the list alphabetically by that column data.
Shows or hides the folders that the files are stored in.
Shows or hides the files. If you click this button when the Show Folders
button
is selected, the area splits into two. The folder is shown on
the left side, and the files and subfolders within it are shown on the
right.
If the Show Files button
is the only one selected, you can click
this button to move up one folder level.
Lets you filter the kinds of files shown below. Depending on the task
you are performing, this field may already be populated with the most
appropriate file type(s).

NOTE: If you select a snippet file outside the project, that file is then copied and
placed inside the project. The image file is stored in the Resources\Snippets folder of
the Content Explorer.
3. Click OK. The original snippet is replaced by the new snippet.
4. Click
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Using Snippet Conditions
Snippet conditions are condition tags that you can apply to content within snippets. With snippet
conditions, you can separate certain snippet content so that it displays in some snippets, topics, or
master pages but not in others. This allows you to use one snippet for many purposes, rather than
having to create multiple snippets. Whereas regular conditions are included or excluded at the target level, snippet conditions are included or excluded at the snippet, topic, or master page level.

HOW TO USE SNIPPET CONDITIONS
1. Create all of the condition tags that you plan to use for separating your snippet content.
NOTE: The more variations that you will have in your snippet content, the more condition tags you will need to create. An average number is four to eight condition tags,
but you may find that you require fewer or more tags than this for snippet content. It
is always preferable to create more condition tags than you may need, rather than to
realize later that you have too few. You can even create a separate condition tag set
to be used specifically for holding your snippet condition tags (while keeping your regular condition tags in other tag sets).

TIP: It is also a good idea to include the word "Snippet" somewhere in the name of a
new snippet condition tag. This way, you can easily identify it, rather than confusing it
with the regular condition tags that you use for other purposes (e.g., online output or
printed output condition tags).
2. Create and open the snippet.
3. Apply the necessary condition tags to the text or other content in the snippet.
TIP: It is a good idea to click the Hide/Show Conditional Indicators button
at the
bottom of the editor so that you can clearly see where the different tags have been
applied in the snippet.
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4. Do one of the following:

TO APPLY SNIPPET CONDITIONS AT THE SNIPPET LEVEL
This method is recommended in most cases. It allows you more flexibility and tends to be
easier to maintain topics as time goes by. Snippet conditions at the snippet level override snippet conditions applied at the topic level.
a. Insert the snippet into the necessary topic, or determine which topic already contains
the snippet.
b. In the topic, right-click the first instance of the snippet and select Snippet Conditions
from the context menu. The Snippet Conditions dialog opens.
c. If you want to exclude a condition tag from the snippet, click the Exclude check box
next to it. If you want to make sure a condition tag is included in the snippet, click the
Include check box next to it. The primary reason for having Include check boxes is to
account for possible conflicts. Snippet conditions set on a snippet override snippet conditions set at the topic level.
EXAMPLE
Let's say you are working in a topic that has several snippet conditions set
at the topic level. When you insert an existing snippet into your topic, you
notice that some of the text in the snippet is excluded using the condition
tag Snippet1. However, the Snippet1 condition tag is also excluded at the
topic level in the topic you are working on, so that text does not appear in
the XML Editor or your output.
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Snippet conditions on individual snippets override those at the topic level.
So in the topic you right-click the snippet and choose Snippet Conditions.
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In the Snippet Conditions dialog, you set the conditions on this snippet to
include Snippet1. While Snippet1 will still be excluded at the topic level, in
this particular snippet, you will be able to see the text that is marked with
that tag.

NOTE: If you want to create more advanced condition tag expressions, you can
switch to Advanced mode.
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WARNING: If you do not select any check boxes at all, all of the tags will automatically be included. If you include only some tags and exclude others, any
remaining tags without check marks for either Include or Exclude will automatically be included. However, if you select Include for any of the tags (even
just one) and do not select Exclude for any tags, all of the other tags that do not
have Include check marks will automatically be excluded. If you want to be safe
and always know that the correct tags are included or excluded, you can make
sure that all of the tags have check marks with either Include or Exclude.
d. Click OK.
e. (Optional) Repeat steps b-d for the other instances of the snippet in your topic.
f. Click

to save your work.

TO APPLY SNIPPET CONDITIONS AT THE TOPIC LEVEL
This method is good if you have snippet conditions set throughout a topic and you want to
include and exclude the same conditions for the entire topic. Otherwise, it is recommended
that you apply snippet conditions at the snippet level.
a. Insert the snippet into the necessary topics, or determine which topics already contain
the snippet.
b. After you determine that a particular topic should display only certain tagged content
from the inserted snippet, open the Content Explorer and select the topic file.
NOTE: If there are several topics that you know in advance will include a particular snippet condition tag, you can open the File List window pane (View >
File List) instead and select all of those files at the same time.

c. In the local toolbar, click

. The Properties dialog for the topic opens.

d. Click the Snippet Conditions tab.
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e. If you want to exclude a condition tag from the topic, click the Exclude check box next
to it. If you want to make sure a condition tag is included in the topic, click the Include
check box next to it. The primary reason for having Include check boxes is to account
for possible conflicts.
EXAMPLE
Suppose you have two condition tags—one called "Beginner" and another
called "Advanced." Let's say that you have a snippet containing three paragraphs. You apply the Advanced tag to the first two paragraphs, and you
apply the Beginner tag to the last two paragraphs.
You have created a topic called "Advanced Set Up." For this topic, you obviously want to include all snippet content associated with the Advanced
tag, but you want to exclude snippet content associated with the Beginner
tag.
By default, Flare will include snippet content associated with both tags,
unless you tell it not to. So you tell Flare to exclude the content associated
with the Beginner tag. The problem is the middle paragraph from the snippet mentioned above. It is associated with both tags. You have told Flare
to exclude content associated with the Beginner tag, and it will do so, overriding the default. But you want to make sure that paragraph is included in
the "Advanced Set Up" topic. That is why you need to make sure you select
the Include check box next to the Advanced tag.

WARNING: If you do not select any check boxes at all, all of the tags will automatically be included. If you include only some tags and exclude others, any
remaining tags without check marks for either Include or Exclude will automatically be included. However, if you select Include for any of the tags (even
just one) and do not select Exclude for any tags, all of the other tags that do not
have Include check marks will automatically be excluded. If you want to be safe
and always know that the correct tags are included or excluded, you can make
sure that all of the tags have check marks with either Include or Exclude.
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TIP: It is a good idea to create enough snippet condition tags in advance. If
sometime later you realize you need to create additional snippet condition tags,
you may find that you need to revisit all of the topics where you have already
inserted snippets with conditions. Why? Because by default the snippets containing the new tags may be displayed in all topics unless you specify otherwise.
f. Click OK.
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EXAMPLE
Let's say that you have a table with 15 rows and four columns. Suppose that the table
needs to be included in 40 topics. Rather than copying and pasting the table 40 times,
you create one snippet containing the table and insert it into those 40 topics. However,
suppose that in 30 of those topics, you need to add three more rows to the table to
explain something. In the remaining 10 topics, the three additional rows are not necessary. Otherwise, the table content is the same in all 40 topics. What do you do? You
have a few options.
The first option is to add a note to the table explaining that the three additional rows
are intended only for some of the topics but not others. However, this might be confusing to your readers.
The second option is to create two separate snippets—one for the 30 topics and
another for the 10 topics. However, this means that you need to maintain identical
information in two different places. And that is no way to single-source your content.
The third option is to create snippet conditions. Here is how you might do it in this
example.
1. Create a condition tag called "Additional Rows."
2. Open the snippet and add the necessary three rows to the table.
3. Using the table row structure bars, apply the new condition tag to the additional
three rows.
4. Use the File List window pane (View > File List) to select the 30 topics requiring
the additional rows, and open the Properties dialog.
5. Select the Snippet Conditions tab.
6. Next to the new condition tag, click the Include check box.
7. Use the File List window pane to select the 10 topics not requiring the additional
rows, and open the Properties dialog.
8. Select the Snippet Conditions tab.
9. Next to the new condition tag, click the Exclude check box.
10. After you save all of your changes and generate the target, you will notice that
the three additional rows are displayed only in the 30 topics where they were
included.
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EXAMPLE
Let's say you are writing a user guide. There is a three-step process that users need to
repeat very frequently, so you create a snippet for those steps. However, there occasionally is a fourth step in the process, where users can optionally select an extra check
box before completing the process. You sometimes need to include this process multiple times in the same topic, so you create a snippet for the four-step process, and
apply a condition to the optional step.
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You add your snippet to the topic...
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...and then exclude the snippet condition on the second instance of the snippet. By
doing this, you won’t see the optional step in that instance of the snippet.
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Later, if you need to edit the content, you only have one snippet to edit.
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TIP: If you are using snippet conditions, you may want to enable snippet condition indicators from the Show tags drop-down
ables a marker

in the XML Editor. This command enables or dis-

that overlays snippets that have snippet conditions applied to them.

If you enable this indicator, you will see it on snippets if you have snippet conditions enabled
at either the topic level or the snippet level.

NOTE: Remember that snippet conditions only apply to a particular instance of a snippet. If
you add new snippet conditions to an existing snippet, be sure to use the Link Viewer to
check that the content in other instances of the snippet is still visible (or hidden) the way
you want it to be.

NOTE: You can generate a report to see topics in your project that contain snippet conditions at the topic or snippet level.
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Using Snippet Groups
Snippet groups are available for pinned snippets and recently used snippets. You can access snippet groups from both the Insert Snippet Link dialog and the Insert Snippet drop-down in the local
toolbar of the XML Editor.

HOW TO USE SNIPPET GROUPS—INSERT SNIPPET LINK DIALOG
1. Open the content file (e.g., topic, snippet).
2. Do one of the following, depending on the part of the user interface you are using:
n

Ribbon Select the Insert ribbon. In the Single Source section select Snippet.

n

Local Toolbar Click the face of the

button.

OR
Click the down arrow next to

, then select More Snippets.

n

Keyboard Shortcut Press CTRL+R.

n

Right-Click Right-click in the editor and select Insert > Snippet. This context menu
option is available only when your cursor is located in certain places in the editor (e.g.,
not in a drop-down effect).

The Insert Snippet Link dialog opens.
3. Select a snippet that you want to use in the Flare interface from a group:
n

Pinned Snippets The Pinned Snippets group is a way to create a list of your favorite snippets so they are easier to find and select in the future.

n

Recently Used Snippets The Recently Used Snippets group displays the last 20 snippets
you have used.
NOTE: Snippets must appear in the Recently Used Snippets group before they can be
pinned. If the snippet you want to pin does not appear in the Recently Used Snippets
group, you can add it to a content file by dragging it from the Content Explorer or
using the Insert Snippet Link dialog.
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4. (Optional) To collapse a snippet group, click . This will close the group, hiding it from view. If
you want to expand the snippet group again, click .

NOTE: When you expand or collapse a snippet group from the Insert Snippet Link dialog, your setting carries over to the Insert Snippet drop-down in the local toolbar of the
XML Editor, so you do not need to collapse the group in both locations. You can
expand or collapse groups in the Insert Snippet drop-down at any time.
5. Click OK.
6. Click

to save your work.

HOW TO USE SNIPPET GROUPS—LOCAL TOOLBAR DROP-DOWN
1. Open the content file (e.g., topic, snippet).
2. In the local toolbar at the top of the XML Editor click the down arrow next to
expands the Insert Snippet drop-down.

. This

3. Select a snippet that you want to use in the Flare interface from a group:
n

Pinned Snippets The Pinned Snippets group is a way to create a list of your favorite snippets so they are easier to find and select in the future.

n

Recently Used Snippets The Recently Used Snippets group displays the last 20 snippets
you have used.
NOTE: Snippets must appear in the Recently Used Snippets group before they can be
pinned. If the snippet you want to pin does not appear in the Recently Used Snippets
group, you can add it to a content file by dragging it from the Content Explorer or
using the Insert Snippet Link dialog.

4. (Optional) To collapse a snippet group, click . This will close the group, hiding it from view. If
you want to expand the snippet group again, click .
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EXAMPLE
Let's say that you have pinned four snippets. You have also recently used 15 snippets.
In the Insert Snippet Link dialog, you will see the Pinned Snippets and Recently Used
Snippets groups.
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In the Insert Snippet drop-down in the local toolbar of the XML Editor, you will see the
same groups with the same snippets in each group.
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.
TUTORIALS

Getting Started Tutorial
Product Foldout Tutorial
Side Navigation Tutorial
Top Navigation Tutorial
Tripane and PDF Tutorial
USER GUIDES

Accessibility Guide

Getting Started Guide

Analysis and Reports Guide

Global Project Linking Guide

Architecture Guide

HTML Help Guide

Autonumbers Guide

HTML5 Guide

Condition Tags Guide

Images Guide

Context-sensitive Help Guide

Importing Guide

DotNet Help Guide

Index Guide

Eclipse Help Guide

Key Features Guide
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Language Support Guide

Source Control Guide: Git

MadCap Central Integration Guide

Source Control Guide: Perforce

Movies Guide

Source Control Guide: Subversion

Navigation Links Guide

Source Control Guide: Team Foundation Server

Plug-In API Guide

Styles Guide

Print-based Output Guide

Tables Guide

Project Creation Guide

Tables of Contents Guide

Pulse Guide

Targets Guide

QR Codes Guide

Templates Guide

Reports Guide

Topics Guide

Reviews & Contributions Guide

Touring the Workspace Guide

Search Guide

Transition From FrameMaker Guide

SharePoint Guide

Variables Guide

Skins Guide

WebHelp Outputs Guide

Snippets Guide

What's New Guide

CHEAT SHEETS

Folders and Files Cheat Sheet
Print Output Cheat Sheet
Shortcuts Cheat Sheet
Structure Bars Cheat Sheet
Styles Cheat Sheet
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